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คํานํา  

      Pilot project การจัดทาํหนังสืออิเล็กทรอนิกสในโครงการหนังสือหายากออนไลน : E-text  ของ
ศูนยวิทยทรัพยากร เปนโครงการริเร่ิมการจัดทําหนังสืออิเล็กทรอนิกสดวยการใชกลองดิจิทัล           
เพื่อถายทอดประสบการณการทํางานและผลงานของโครงการฯใหเปนที่ประจักษ ขาพเจาในฐานะ
ผูปฏิบัติงานไดรวบรวมขั้นตอนงานและผลสําเร็จแหงงานจัดทําเปนขอเขียนสองภาค ภาคที่ 1 คือ การ
จัดทําหนังสืออิเล็กทรอนิกสในโครงการ หนังสือหายากออนไลน : E-text   เลมนี้ และภาคที ่2 คือ 
ผลงานภาพหนังสือหายากอเิล็กทรอนิกส  และนอกจากการนําเสนอในแบบสิ่งพิมพแลว ผูสนใจ
สามารถศึกษาจากผลงานที่เผยแพรทางอิเล็กทรอนิกสใน CUIR ไดดวย  

เมื่องานถายภาพริเร่ิมความคิดในการใชกลองดิจิทัลถายทาํหนังสือหายากของหอสมุดกลาง 
ศูนยวิทยทรัพยากรนั้น การใชกลองถายภาพถายทําหนังสือยังไมใชวิธีการที่ใชกันแพรหลาย สวนใหญ
นิยมใชการกวาดสัญญาณภาพเปนไฟล ดวยเครื่องกราดสญัญาณ (flatbed scanner) หากเนื่องดวย
ทรัพยากรสารสนเทศของหอสมุดกลางเปนทรัพยสินทางปญญาที่มีทั้งคุณคาและราคา ปฏิบัติการใดกับ
ตัวเลมหนังสือควรตองใชความระมัดระวังเปนอยางยิ่งทีจ่ะไมทํารายลักษณะทางกายภาพ การใชกลอง
ถายภาพจึงเปนทางเลือกที่ดทีี่สุด แตสําหรบัผูปฏิบัติงานแลว งานนี้นับเปนงานที่ทาทายความสามารถ 

      เนื่องจากโครงการนี้เปนโครงการนํารองเพื่อนําการผลิตหนังสืออิเล็กทรอนิกสดวยการ
ถายภาพ  ระหวางดําเนนิการชางภาพตองใชทั้งศาสตรและศิลปเพื่อใหงานบรรลุผลตามวัตถุประสงค 
เร่ิมจากการประสานงานที่ดีระหวางทีมงาน (ทั้งศูนยโสตทัศนศึกษากลาง และหอสมดุกลาง) การ
ประมวลประสบการณและความรูในงานถายภาพที่มีอยูและที่ตองศึกษาเพิ่มเติม มาดัดแปลงเครื่องมือ
และวิธีการที่เหมาะสมเพื่อใหไดผลงานภาพที่ดีที่สุด  ตลอดขั้นตอนการเตรียมงาน การปฏิบัติงานและ
การเรียงรอยผลงานใหเปนชิน้งานพรอมบริการนั้น ลวนเปนผลจากวิริยะ อุตสาหะ และความมุงมัน่ของ
ผูรวมงานทุกคน ผลสําเร็จแหงงานไมเพียงเปนความภูมใิจของผูปฏิบัติงานเทานั้น  โครงการนี้ยังเปน
ตนแบบเพื่อการศึกษาสําหรบังานหนังสืออิเล็กทรอนิกสสําหรับองคกร/สถาบันอื่นๆ ดวย  

          ประโยชนอันพึงเกดิจากความรูของผลงานนี้ ขอมอบแดผูปฏิบัติงานโครงการฯทุกทาน รวมทั้ง
ศูนยวิทยทรัพยากรที่เปดโอกาสใหผูปฏิบัติงานไดใชความรูความสามารถสรางผลงานไดเต็มที ่
ขอบกพรองใดใดในงานนี ้ขาพเจาขอนอมรับเพื่อปรับปรงุแกไขใหงานสมบูรณตอไป         
          ชัชวาล   ศรีสละ 
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ชัชวาล ศรีสละ 

 
 สําหรับบรรณารักษและ/หรือประชาคมหองสมุดน้ัน เม่ือเอยถึงเรื่องราวของหนังสือหายาก 
ความคิดจะมุงไปที่เรื่องการอนุรักษเปนลําดับแรก เน่ืองจากในวงวิชาชีพบรรณารักษทุกคนทราบดีวา 
หนังสือหายากเปนทรัพยากรสารนิเทศที่มีคาในเชิงประวัติศาสตร  สวนใหญเปนหนังสือที่มีอายุมาก สภาพ
หนังสือไมพรอมใหบริการช้ันเปด  ดังน้ันหนวยงานบริการสารนิเทศสวนใหญที่มีหนังสือหายากใน
ความหมายนี้ จึงมีการจัดการสารนิเทศแบบชั้นปดและเนนที่การอนุรักษ/รักษาหรือคงสภาพสารนิเทศ
เหลาน้ัน  

เม่ือกระบวนการทางอิเล็กทรอนิกสเขามามบีทบาทในงานหองสมุด หนวยงานบริการสารนิเทศ
หลายแหงเร่ิมใชการแปลงสือ่เปนดิจิทัล (digitization) เพ่ือการใหบริการสารนิเทศ และการอนุรักษ  ในป 
2546 หอสมุดกลางและศูนยโสตทัศนศึกษา ศูนยวิทยทรัพยากร โดยงานถายภาพไดเริ่มโครงการนํารองใน
การอนุรักษหนังสือเกาหรือหนังสือหายากที่จัดเก็บที่หอสมุดกลาง โดยใชการถายภาพดิจิทัลถายภาพ
หนังสือหายากเหลาน้ันเพื่อการคงสภาพตวัเลม และใหใชบริการในรูปไฟลดิจิทัลแทน 
 งานถายภาพซึ่งเปนผูรับผิดชอบโดยตรงในกระบวนการทางเทคนิค มีหนาที่ในการประสานงาน
การถายภาพตั้งแตเริ่มโครงการ โดยรับผิดชอบการถายภาพหนังสือหายาก ซ่ึงเปนหนังสือเกา สภาพรูปเลม
ไมสามารถใชการสแกนภาพได เพราะจะทําใหหนังสือชํารุดเสียหาย หนังสือเกาหรือหนังสือหายาก
เหลาน้ันตองใชความพิถีพิถัน คอยพลิกทีละหนา จัดตนฉบับเลมหนังสือใหอยูในตําแหนงที่จะถายไดภาพที่
คมชัดที่สุดเทาที่จะเปนไปได และใหมีความสม่ําเสมอเทากันทุกหนา ทุกบทและทุกตัวอักษร ลักษณะการ
จัดถายเชนน้ีสอดคลองกับการจัดถายงานภาพตนฉบับ วัสดุ ส่ิงของ ปฏิบัติและรับผิดชอบอยู การดําเนินงาน
ทั้งหมดตองมีการทดลองทําเปนโครงการนํารอง (pilot project)  รวมหนังสือหายาก จํานวน 28 เลม และ
รายงานกิจการของจุฬาลงกรณมหาวิทยาลยั ป 2540 และ 2541 (2 เลม) จากนั้นไดนําขึ้น website ของศูนย
วิทยทรัพยากร เปนบริการหนังสือหายากออนไลน  
 ในการดําเนินงานตามโครงการนี้ งานถายภาพถายภาพจากหนังสือหายากที่ใหบริการในหอง
หนังสือหายากของหอสมุดกลาง รวม 30  เลม (2990 หนา) ผูสนใจศึกษาขอมูลเพ่ิมเติมเกี่ยวกับหนังสือหา
ยากของหอสมุดกลาง สามารถเขาดูไดที่  http://www.car.chula.ac.th/web/form/resources/ หรือสามารถ
ติดตอใชบริการเลมจริงไดที่หองหนังสือหายาก หอสมุดกลาง ศูนยวิทยทรัพยากรช้ัน 6 
           สําหรับรายละเอียดทางบรรณานุกรมของผลงานเหลาน้ีปรากฏตามเอกสารในหนาตอไป 
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TITLE: ศิลปกรรมงานสะสมของจุฬาลงกรณมหาวิทยาลัย 
AUTHOR: นิทรรศการศิลปกรรมงานสะสมของจุฬาลงกรณมหาวิทยาลัย 
(2538 : จุฬาลงกรณมหาวิทยาลัย)  
YEAR: 2538, 83 หนา 
NOTE: ณ หอศิลปวิทยนิทรรศน สถาบันวิทยบริการ จุฬาลงกรณ
มหาวิทยาลัย 26 มีนาคม - 25 เมษายน 2538 

 
 
 
 

TITLE: ครูเหม เวชกร 
AUTHOR: นิทรรศการภาพวาดวิจิตร ครูเหม เวชกร (2539 : 
จุฬาลงกรณมหาวิทยาลัย) 
YEAR: 2539, 24 หนา 
NOTE: ณ หอศิลปวิทยนิทรรศน สถาบันวิทยบริการ จุฬาลงกรณ
มหาวิทยาลัย 21 มีนาคม - 26 เมษายน 2539 

 
 
 
 

 

TITLE: กันปวย 
AUTHOR: มงกุฎเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๔๕๖, ๑๑๗ หนา 
NOTE: พิมพในงานพระราชทานเพลิงศพ มหาเสวกตรี พระยาราชอักษร 
(ใช อัศวรักษ) 

 
 
 

 
TITLE: กุศโลบาย 
AUTHOR: มารแชล, รอเบอรต 
YEAR: ๒๕__, ๑๖๘ หนา 
NOTE: แปลโดย ศรีอยุธยา (พระบาทสมเด็จพระมงกุฎเกลาเจาอยูหัว) 
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TITLE: ขอมดําดิน แถลงเรื่องตามตํานาน และสันนิษฐานโบราณคดี
และเปนบทกลอนลคร 
AUTHOR: มงกุฎเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๕__, ๔๓ หนา 

 
 

 
 
 
 

TITLE: โคลงภาพพระราชพงศาวดาร 
AUTHOR: จุลจอมเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๕๑๓, ๑๐๗ หนา 
NOTE: พิมพเปนอนุสรณในงานพระราชทานเพลิงศพ หมอมจันทร เท
วกุล ณ เมรุวัดธาตุทอง 1 มิ.ย. 2513 

 
 
 
 
 

TITLE: โคลงสุภาษิตเจานาย พระราชนิพนธและพระนิพนธทรงเมื่อใน
รัชกาลท่ี ๕ 
AUTHOR: จุลจอมเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๔๖๓, ๑๓๒ หนา 

 
 
 

 
 
 
TITLE: โคลงสุภาษิตใหม 
AUTHOR: จุลจอมเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๔๕๕, ๑๓๒ หนา 
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TITLE: เงาะปา 
AUTHOR: จุลจอมเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๕๒๕, ๓๒ หนา 
NOTE: ภาพและคําบรรยายโดย เหม เวชกร 

 
 

 
 

TITLE: ชุมนุมพระราชนิพนธในรัชกาลที่ ๕ ภาคปกิณณกะ ภาค ๑ 
AUTHOR: จุลจอมเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๔๙๓, ๔๙ หนา 
NOTE: พระเจาบรมวงศเธอ พระองคเจาวาปบุษบากร โปรดใหพิมพใน
งานพระราชทานเพลิงพระศพ พระเจาบรมวงศเธอ พระองคเจา 
ประภาพรรณพิไลย ณ พระเมรุทองสนามหลวง 
 

 
 
 
 
 

TITLE: เทศนาพระราชประวัติ พระบาทสมเด็จพระจอมเกลาเจาอยูหัว 
AUTHOR: จุลจอมเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๕๐๕, ๑๖๐ หนา 
NOTE: พิมพเปนที่ระลึก ในงานประดิษฐาน พระบรมรูป พระบาทสมเด็จ
พระจอมเกลา บนพระนครคีรี จังหวัดเพชรบุรี พ.ศ.๒๕๐๕ 
 
 
 

 

 

 
 
TITLE: ธรรมเนียมราชตระกูลในกรุงสยาม 
AUTHOR: จุลจอมเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๕๐๑, ๖๔ หนา 
NOTE: คณะพระภิกษุสามเณร วัดบวรนิเวศวิหาร พิมพอุทิศถวายสวน
กุศล พระเจาบรมวงศเธอ พระองคเจาอาทรทิพยนิภา ในงานพระราชทาน
เพลิงพระศพ ณ พระเมรุ สุสานหลวง วันเทพศิรินทราวาส วันท่ี ๕ 
กรกฎาคม ๒๕๐๑ 
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TITLE: ตํานานชาติฮั่น 
AUTHOR: มอรแลนด, อาเทอร 
YEAR: ๒๕__, ๑ เลม (ไมมีเลขหนา) 
NOTE: แปลโดย รามจติติ (พระบาทสมเด็จพระมงกุฎเกลาเจาอยูหัว) 

 
 
 
 
 

 
TITLE: บทลครเรื่องเงาะปา 
AUTHOR: จุลจอมเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๔๖๖, ๑๓๕ หนา  

 
 
 
 
 

 
TITLE: ประชุมโคลงสุภาษิตพระราชนิพนธในรัชกาลที่ ๕ 
AUTHOR: จุลจอมเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๔๖๖, ๖๐ หนา  

 

 
 
 
 
 
TITLE: ประเพณีทําบุญวันเกิด 
AUTHOR: จุลจอมเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๔๗๘, ๕, ๗๐ หนา  
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TITLE: พระบรมราชาธิบายเรื่องเครื่องราชอิศริยาภรณของกรุงสยาม 
AUTHOR: มงกุฎเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๔๖๓, ๒๓, ๑๕ หนา  

 
 

 
 

 
 
TITLE: พระบรมราชาธิบายเรื่องสามัคค ี
AUTHOR: จุลจอมเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๔๘๙, ๒๒ หนา 

 
 

 
 
 
 
 

 
 
 
TITLE: พระบรมราโชวาทตักเตือนขาราชการในพระราชสํานักเรื่อง
ประพฤติผิดพระราชนิยมและกฎหมายแผนดิน 
AUTHOR: มงกุฎเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๔๖๖, ๑๒ หนา  

 

 
 
 
 
TITLE: พระบรมราโชวาทพระบาทสมเด็จพระรามาธิบดีท่ี 6 พระราชทาน
แดทหารในกองทัพบกสยาม 
AUTHOR: มงกุฎเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๔๖๓, ๙๒ หนา 
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TITLE: พระบรมราโชวาทเสือปา 
AUTHOR: มงกุฎเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๔๖๒, ๑๕๒ หนา 

 
 
 
 
 

 
 
TITLE: พระราชดํารัสในพระบาทสมเด็จพระจุลจอมเกลาเจาอยูหัว 
AUTHOR: จุลจอมเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๔๕๘, ๒๗๒ หนา 

 
 
 
 

TITLE: พระราชดํารัสในพระบาทสมเด็จพระจุลจอมเกลาเจาอยูหัวทรง
แถลงพระบรมราชาธิบายแกไขการปกครองแผนดิน 
AUTHOR: จุลจอมเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๔๗๐, ๖๔ หนา 
NOTE: พิมพพระราชทานแจกเนื่องในงานทรงบําเพ็ญพระราชกุศลสนอง
พระเดชพระคุณพระบาทสมเด็จพระพุทธเจาหลวง ในวันตรงกับเสด็จ
สวรรคต ท่ี ๒๓ ตุลาคม พ.ศ. ๒๔๗๐  
 

 
 

 

 
 
 
 
 
 
 
TITLE: พระราชดํารัสในพระบาทสมเด็จพระมงกุฎเกลาเจาอยูหัว 
AUTHOR: มงกุฎเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๔๗๒, ๓๒๙ หนา  
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TITLE: พระราชนิพนธคํานมัสการคุณานุคุณ 
AUTHOR: มงกุฎเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๔๖๘, ๒๗ หนา  

 
 
 
 
 

TITLE: พระราชนิพนธในพระบาทสมเด็จพระจุลจอมเกลาเจาอยูหัวทรง
วิจารณเรื่องพระราชพงศาวดารกับเรื่องราชประเพณีการต้ังพระมหาอุปราช
AUTHOR: จุลจอมเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๔๗๙, ก-ฆ, ๙๕ หนา 
NOTE: สมเด็จพระเจาอยูหัวรัชกาลท่ี ๗ โปรดใหตีพิมพแจกในงาน
พระราชทานเพลิงพระศพ พระเจาบรมวงศเธอ พระองคเจาอรพินทุเพญ
ภาคย ณ วันท่ี ๒ กุมภาพันธ พ.ศ. ๒๔๗๙ 
 
 
 
 

 
 
 
 
 

 

TITLE: พระรวง 
AUTHOR: มงกุฎเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๔__, ๑๑๗ หนา  

 

 
 
 
 
 
TITLE: ภาพฝพระหัดถชนิดภาพลอเสนหมึก 
AUTHOR: มงกุฎเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๔__, ๒๒ หนา 
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TITLE: ภาพฝพระหัดถชนิดภาพเสนขาด 
AUTHOR: มงกุฎเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๔๖๓, ๖ หนา 

 
 
 
 
 

TITLE: มัทนะพาธา 
AUTHOR: มงกุฎเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๔๖๗, ๑๔๖ หนา  
NOTE: ตํานานแหงดอกกุหลาบ 

 
 
 
 
 

 
TITLE: เมืองไทยจงต่ืนเถิด 
AUTHOR: มงกุฎเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๔๘๑, ๗๘ หนา 

 
 
 

 
TITLE: เรื่องตามใจทาน 
AUTHOR: เช็คสเปยร, วิลเลียม 
YEAR: ๒๔__, ๑๗๑ หนา 
NOTE: สมเด็จพระรามาธิบดีศรีสินทรฯ พระมงกุฎเกลาเจาแผนดินสยาม 
ทรงแปลและประพันธเปนกาพยภาษาไทย 
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TITLE: เรื่องเที่ยวเมืองพระรวง 
AUTHOR: มงกุฎเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๔๕๐, ๒๔๔ หนา  

 
 
 
 
 

TITLE: เรื่องพระราชพิธีพืชมงคลแลจรดพระนังคัลพระราชนิพนธรัชกาล
ที่๕ 
AUTHOR: จุลจอมเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๔๖๕, ๖๐ หนา  
NOTE: พิมพแจกในการแรกนาขวัญ เมื่อวันที่ ๘ พฤษภาคม พ.ศ. 
๒๔๖๕ 
 
 

 
 
 
 
 

TITLE: เวนิสวานิช 
AUTHOR: เชคสเปยร, วิลเลียม 
YEAR: ๒๔๕๙, ๑๘๖ หนา 
NOTE: แปลเปนกลอนโดย พระบาทสมเด็จพระรามาธิบดีศรีสินทรมหา
วชิราวุธ พระมงกุฎเกลาเจาอยูหัว 

 
 
 

TITLE: ศกุนตลา 
AUTHOR: กาลิทาส 
YEAR: ๒๕__, ๑๕๐ หนา 
NOTE: พระบาทสมเด็จพระปรเมนทรมหาวชิราวุธพระมงกุฏเกลา
เจาอยูหัวทรงพระราชนิพนธ ประกอบดวยคํานํา และอภิธานอธิบายศัพท 
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TITLE: สักระวานาหนาว 
AUTHOR: มงกุฎเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๔__, ๒๒ หนา 
NOTE: รวบรวมจากหนังสือพิมพ "ดุสิตสมิต" 

 
 
 
 
 

TITLE: หนังสือหลักราชการ 
AUTHOR: มงกุฎเกลาเจาอยูหัว, พระบาทสมเด็จพระ 
YEAR: ๒๔๕๗__, ๔๔ หนา 
NOTE: พิมพพระราชทานแจกขาราชการในการพระราชพิธีตะรุษะ
สงกรานต 
 

 
 
 
 
 

 
 
TITLE: รายงานกิจการจฬุาลงกรณมหาวิทยาลัยป2540 

 

 
 
 
 
 
 
 
TITLE: รายงานกิจการจฬุาลงกรณมหาวิทยาลัยป2541 
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ตัวอยางผลงานหนังสืออิเล็กทรอนิกส 
 

เรื่อง มัทนะพาธา 
หรือ 

ตํานานแหงดอกกุหลาบ 
ละครพูดคําฉันท ๕ องก 

สมเด็จพระรามาธิบดีศรีสินทรมหาวชิราวุธทรงพระราชนิพนธ 
พ.ศ. ๒๔๖๗  (จํานวน ๙ หนา) 
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การดําเนินงาน การจัดทําหนังสืออิเล็กทรอนิกสในโครงการ หนังสือหายากออนไลน : E Text 
 
เร่ิมจากการคัดเลือกหนังสือเพ่ือการถายภาพนั้น บรรณารักษจะคัดเลือกหนังสือหายากเลมที่มี

คุณภาพดี และชางภาพตองสํารวจอีกคร้ังวาสภาพหนังสือสมบูรณไหม?  มีหนาครบทุกหนา และตองวาง
แผนการถายภาพ บางเลม หนาหนังสือมีเฉพาะหนาขวา  บางเลมมีทั้ง 2 หนา บางเลมเริ่มตนดวยเลขหนา 1, 
2, 3 บาง เปนอักษร ก ข ค บาง บางเลมมหีนาพับซอนขยาย เชน หนาตารางหรือกราฟ หรือแผนท่ี ซ่ึงทําให
ปฏิบัติงานไดยาก ส่ิงที่ควรระวังที่สุดคือ สภาพที่หนังสือหายากที่มีอายุเกาและเสื่อมตามสภาพใชงาน  และ/
หรือกรอบมาก ๆ เม่ือชางภาพถายไปและพลิกไปทีละหนาแผนกระดาษในหนังสืออาจจะกรอบและหัก
ชํารุดเสียหายได 
 
ขั้นตอนเตรียมการเพื่อการถายภาพ 
 วิธีการใหไดมาซึ่งภาพดังกลาว ชางภาพเรียกวา เปนการถายกอปปภาพ  ภาพท่ีจะถายกอปปอาจจะ
เปนภาพจากหนังสือ ภาพเขียน ตัวหนังสือ ภาพลายเสน ฯลฯ  ก็ได ในการถายกอปปภาพดังกลาว จะขอ
อธิบายเคร่ืองมือทางการถายภาพเพ่ือใหเขาใจกระบวนการทํางานได  ดังตอไปนี้ 

1. กลองและเลนสถายใกล 
2. แทนกอปปภาพ (Copy stand) 
3. ไฟสองสวาง 
4. สายล่ันไกชัตเตอร  
5. ขาตั้งกลอง 
6. กระดาษสีดํา                
7. กระจกดาน (Matte mirror) 

 
 
การใชอุปกรณ เครื่องมือและวิธีการปฏิบัติงานการถายภาพหนังสือหายาก 
 
1. กลองและเลนสถายใกล 
 เน่ืองจากปจจบุันกลองดิจิทัลมีบทบาทในงานถายภาพมากเพราะใชงานไดสะดวก (เม่ือเทียบกับ
การอนุรักษในสมัยกอนโดยใชไมโครฟลม) กลองดิจิทัลมีหลายรูปแบบและมีใหเลือกหลายรุนหลายขนาด
ในการถายภาพหนังสือหายากทีละหนา ขอแนะนําในการเตรียมกลองดิจิทัลในลักษณะของงานอนุรักษ ควร 
เลือกชนิดกลองดิจิทัลชนิดที่สามารถถอดเปลี่ยนเลนสได เน่ืองจากตองใชเลนส แมคโคร ซึ่งเปนเลนสท่ีมี
ความสามารถในการถายภาพระยะใกลกับวัตถุมากๆ ได เพ่ือใหไดภาพถายที่คมชัดทุกระนาบองศา  



 22

กลองดิจิทัล มาจากคาํภาษาอังกฤษวา Digital single lens reflex (DSLR) คือ กลองดิจิทัล สะทอนภาพแบบ
เลนสเด่ียว กลองแบบน้ี มีหลายฟอรแมตดวยกัน ฟอรแมตที่นิยมโดยทั่วไปคือ 35 DSLR และฟอรแมตนี้ก็
จะมีกลุมเลนสใหเลือกใชมากมาย ทั้งเลนสปกติ เลนสมุมกวาง เลนสดึงภาพ (Zoom) เลนสถายภาพ
ระยะไกลรวมทั้งเลนสแมคโครดวย 
กลองที่งานถายภาพเลือกใช คือ กลอง NIKON  รุน D100  เปนกลองดิจิทัลขนาดฟอรแมต 35 DSLR ให
ไฟลไดหลายรูปแบบ  SPEC กลองดิจิทัลรุน NIKON  D 100 ดังกลาวน้ี มีนํ้าหนักเบา  มีความทนทาน 
คลองตัว มีความเหมาะสมในการใชงาน   ไฟลภาพจากกลองจะเปนไฟลภาพขนาดใหญ (มากถึง  6.31  ลาน
พิกเซล) และเปนไฟลภาพ Jpeg  และ Tiff  เม่ือถายโอนไปยังคอมพิวเตอร มีคุณภาพในระดับกลองโปร   
Nikon  D 100 ใช  CCD  ขนาด 23.7 x 15.6 มม.   มีคาไดนามิกเรนจกวาง  เก็บรายละเอียดไดดี     ทั้งสีที่มี
คอนทราสตและความคมชัด  กลอง Nikon  D 100   มีโหมดสีใหเลือก 3 แบบ ตามความเหมาะสมของงาน 
คือ  1) Mode  sRGB   ชวงของโทนสีกวาง  สีดูเปนธรรมชาติ  สีผิวของบุคคล  เหมาะงานถายภาพบุคคล    
      2) Mode  Adobe  RGB  ชวงกวางสีมากที่สุด  ไฟลภาพสีมีคุณภาพสูง  สําหรับงานถายภาพเชิงพาณิชย  
เชน สินคาหรือจัด Subject   และ  prop  ใน Studio  และ     
      3) Mode   sRGB  Optimised  ความอิ่มตัวของสีสูงเปนพิเศษสําหรับถายภาพทิวทัศน  ธรรมชาติ  
 
รายละเอียดและคุณลักษณะกลองดิจิทัล  Nikon  D 100 
 กลองดิจิทัลมีความละเอียด  6.31  ลานพิกเซล,  ความไวแสงสูงสุด  ISO 200 – 6400,  จอ LCD  
ขนาด 1.8 น้ิว , นํ้าหนัก 730  กรัม, มีคุณลักษณะของกลอง  (Specification) ดังน้ี 
ความละเอียด 6.31 Mpixel 
ขนาดภาพสูงสุด 3008x2000 
ขนาดภาพเล็กสุด 1504x1000 
ขนาดเซ็นเซอร 23.7x15.5 mm 
เซนเซอร CCD 
ตัวคูณโฟกัส 1.5 
ซูมเลนส n/a 
ซูมดิจิทัล No 
ระบบโฟกัสอัตโนมัติ Yes  
ระบบแมนนวลโฟกัส Yes 
ความไวแสง auto,200-1600,3200,6400 
โหมด  Aperture  priority Yes  
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เลนสถายใกล 
 เลนสของกลอง NIKON มีใหเลือกมากมาย แตเลนสที่นํามาถายกอปปน้ัน  ควรเลือกใชเลนสแมค
โคร (MACRO LENS) เน่ืองจากเลนสแมคโครถูกออกแบบใหโฟกัสไดมากกวาเลนสปกติ ทําใหสามารถ
ถายภาพวัตถุที่มีขนาดเล็กมาก ๆได  ทําใหไดอัตราขยายสูงๆ  เลนสแมคโครจึงเหมาะสมในการนํามาถาย
กอปปภาพ โดยเฉพาะหนากระดาษหนังสือหายาก เพ่ือเก็บรายละเอียดของตัวหนังสือไดดี ย่ิงหากเปน
ตัวหนังสือที่มีวิธีพิมพแบบเกา ซ่ึงใชตัวบล็อกตะกั่วที่บางครั้งความคมชัดของหมึกพิมพบนตัวตะกั่วไม
สม่ําเสมอ  เลนสแมคโครที่มีคุณภาพจะเก็บรายละเอียดเหลาน้ีไดดีทีเดียว ดวยเหตุที่วาเลนสแมคโครมีคุณ
ลักษณะเฉพาะ คือ แมคโครนั้นหมายถึง การถายภาพวัตถุที่ Life size คือ 1: 1 น่ันคือ ไดภาพวัตถุที่
อัตราสวนของภาพในขนาดเทาจริง  อัตราสวน 1 :1 มีความหมายวา  สามารถถายภาพไดขนาดภาพในฟลม
เทากับขนาดของวัตถุ  สวนอัตราสวน  1 : 2  หมายถึง  ขนาดภาพในฟลมเทากับขนาดครึ่งหนึ่งของวัตถุ  (ใน
ปจจุบันคงกลาววา  ภาพบน  CCD  หรือภาพบน  CMOS)  เลนสแมคโครแท ๆ คุณภาพดี จะมีระยะโฟกัส
ใกลสุดมาก ๆ น่ันคือ  ระยะที่ 1:1 และ 1:2 (ในปจจุบันเลนสแมคโครรุนใหมมักทําระยะที่ 1:1)   

การประเมินในเรื่องของความคมชัดของการถายภาพตัวหนังสือในหนังสือหายากนั้น เลนสแมค
โคร 1:1 จะใหความคมชัด (ความชัดลึก) ที่ตื้นมาก (แตในระยะโฟกัสท่ีเจตนาใหชัดและชางภาพโฟกัสได
ชัดน้ัน จะมีความคมชัดมาก)  การเลือกจุด(ตําแหนง)โฟกัสในการใชงานเลนสแมคโคร จึงตองระมัดระวัง
มาก  การโฟกัสที่ผิดพลาดไปเล็กนอย จะทําใหจุดสําคญัเสียไป ตองระมัดระวังมากย่ิงข้ึนสําหรับหนังสือหา
ยาก  เพราะกระดาษแผน ๆ อยางที่เห็นวางายน้ัน หากระนาบโฟกัสไมไดมุมซายบนชัด  มุมลางขวากระเดิด 
ผลคือ ภาพไมโฟกัส  ผลงานก็จะไมมีคุณคาในการถนอมและเก็บรักษาอยางมีคุณคา (และไมอาจอางไดวา
เปนตนแบบงานอนุรักษ) 

 
เลนสซูมแมคโคร (Macro zoom lens)  

กลองดิจิทัล 35 DSLR นิยมใชเลนสซูมกันมากขึ้น เพราะใหความสะดวกและคลองตัว  ชางภาพ
สามารถปรับทางยาวโฟกัสของเลนส ใหมีคาทางยาวโฟกัสตามคาทีต่องการ ทําใหเลือกตัดสวนและ
ถายภาพไดอยางงายๆ ไมตองเสียเวลาถอดเลนสและเปล่ียนเลนส  เพราะเลนสซูมจะมีชุดของเลนสอยูในตัว
กลอง  เลนสซูมแมคโคร เชน เลนส 28-105 มม. จะมีการถายภาพแบบแมคโครเขามาดวย ทําใหเลนสเหลาน้ี
เปนเลนสอเนกประสงค แตถือวาไมใช แมคโครแท เปนแมคโครเทียม (Psudo macrolens)  เลนสแมค
โครเทียม มีขอระวังในการใชงานที่วา นอกจากตัวเลนสมักจะใหญและหนักแลว ในการออกแบบตัวเลนส
หน่ึงตัวใหใชงานได อเนกประสงคน้ัน ตองเปนเลนสซูมที่มีชิ้นเลนสหลายชิ้น ทําใหตัวเลนส(กินแสง) 
สูญเสียแสงไปมาก  ภาพท่ีไดจึงมักไมคอยคมชัด สีก็อาจไมสดใสอยางที่ควรจะเปน  เลนสแมคโครซูม
ดังกลาวน้ี  เปนสวนหน่ึงของจุดขายของผูผลิตเลนสโดยเฉพาะผูผลิตเลนสอิสระมักจะชอบผลิตเลนสซูมให
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มี Mode แมคโครขึ้นมา  ซ่ึงมักมีกําลังขยายอัตราสวน 1 : 4  หมายถึง ขนาดของภาพในฟลมจะเปนขนาด ¼ 
ของขนาดวัตถุที่ถายนั้น  และเมื่อสังเกตภาพขยายใกล ๆ เม่ือเทียบกับเลนสแมคโครแท ๆ จะพบวา  ภาพที่
ไดมีอาการขอบภาพมืดและเกิดการบิดเบี้ยวของรูปทรงขึ้น  (Weakness and distortion)  แตในปจจุบัน 2009  
เลนสประเภทน้ีมีการปรับปรุงคุณภาพดีขึ้น  ไมกินแสงและมีคุณภาพของภาพที่ไดดีขึ้น 
 
2. แทนกอปปภาพ (Copy stand) 
 แทนกอปปภาพ (Copying stand)  ประกอบดวยเสาและแปนสําหรับยึดจับกลองถายภาพ ตัวเสายึด
กับแผนกระดานเพื่อใหม่ันคงในการใชงาน ตัวเสามีแปนยึดสําหรับติดกลอง มีอุปกรณมือหมุนใหเล่ือนเขา
ออกและใหเล่ือนสูง – ตํ่า ตามความเหมาะสมในการใชงานไดโดยสะดวก   แทนกอปปบางรุนจะมีไฟสอง
สวางติดมาดวยหรืออาจซ้ือเพ่ิมใหเหมาะสมกับงาน  ควรเลือกใชแทนกอปปใหมีขนาดพอเหมาะกับชนิด
ของกลองและเลนสที่จะใชถาย   ในกรณีของงานถายหนังสือหายากของศูนยวิทยทรัพยากร จุฬาฯ  หนังสือ
หายากสวนใหญมี ขนาด A5  (ประมาณ พ็อคเก็ตบุค)และขนาด A4   งานถายภาพจึงเลือกใชแทนกอปป
ขนาดกลาง พ้ืนของแทนกอปปควรเลือกชนิดสีดําหรือเทา  ควรเปนสีดาน แตไมควรเลือกสีขาว เพราะการ
วัดแสงถายภาพจะหลอกเครื่องวัดแสงใหผิดพลาดได 
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3. ไฟสองสวาง   
ในการเตรียมการเรื่องของแสงนั้น งานถายภาพไดมีการพัฒนาและปรับปรุงเครื่องมือถายภาพและ

ไฟถายภาพ (ตามรายละเอียดปรากฏในหนาตอไป) เพ่ือใหเหมาะสมกับโครงการจัดทําหนังสือ
อิเล็กทรอนิกสครั้งน้ี  ในการผลิตภาพดิจิทัล ภาพสีและสไลดสี อาจมีปญหาเร่ืองคุณภาพงาน อันเปนผล
เน่ืองจากการจดัแสงที่ไมเหมาะสม ไมถูกตอง   แตเดิมภาพสี สไลดสีน้ัน นิยมถายภาพโดยใชฟลมชนิด 
Daylight  การถายภาพสีและสไลดรูปภาพจากหนังสือหรือแคปช่ัน  ตองใชแสงแดดในชวงเวลา 9.30 - 
11.00 น. ถึงจะไดสีดีและถูกตอง ถาถายในชวงบาย ก็มักจะออกอมสีฟา (blue) มากจนเกินไป นอกจากนั้น
ในวันที่แดดไมดี, วันฝนตก ก็ไมสามารถถายสไลดได แตเม่ือมาเปนภาพจากดิจิทัลและการถายที่ใชกลองดิ
จิทัล  ชางภาพตองใชการปรับ WB  (White Balane) และ ก็ตองเลือก light source  ใหถูกตอง 
  
ความเขาใจในเรื่องของทฤษฎีของแสงและสี 
3.1) อุณหภูมิสีของตนกําเนิดแสงไฟประดิษฐ (Artificial   Light) 
 หลอดไฟประดิษฐมีหลากหลายชนิด  หลายประเภท  แตละแบบก็จะใหแสงสวาง   สีและ มี
อุณหภูมิสีแตกตางกันตามชนิดของการผลิตเพ่ือนําไปใชงาน  โดยรวมๆแลว อาจแสดงตารางเปรียบเทียบได
ดังน้ี 
 
ชนิดของตนกําเนิดแสง อุณหภูมิสีโดยประมาณ K 
เปลวเทียน 
หลอดไฟทังสเตนที่ใชในบาน 100วัตต 
หลอดไฟทังสเตนที่ใชถายภาพในสตูดิโอ500 วัตต 
หลอดไฟทังสเตนที่ใชถายภาพ  500 วัตต 
หลอดแฟลชที่ไสหลอดเปนอลูมิเนียม 
หลอดแฟลชที่ไสหลอดเปนเซอรโคเนียม 
หลอดแฟลชสีนํ้าเงิน 
หลอดไฟซีนอน 
หลอดแฟลชอิเล็กทรอนิกส 

2600° 
2800° 
3200° 
3400° 
3800° 
3950° 
5500° 
5400° 
5000°- 6000° 

 
3.2) หลอดไฟฟลูออเรสเซนต  (Fluoresent  lamps)   
 หลอดไฟชนิดน้ีเปนหลอดที่ใหแสงสวางมากกวาหลอดแบบเผาไส ( Incandesent  lamps)  
ส้ินเปลืองพลังงานนอยกวา  ไมรอน  และอายุการใชงานยาวนานกวา  หลอดไฟฟลูออเรสเซนตบางประเภท  
จะสรางมาใหมีสีแสงถูกตองที่สุด  โดยมีคุณลักษณะของหลอดกํากับมา ดังตัวอยางตารางแสดงคา
เปรียบเทียบชนิดของหลอดไฟวาวแสงแตละประเภททีใ่หคาอุณหภูมิสีเทียบเคียงแตกตางกันออกไป 
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ชนิดของหลอดไฟวาวแสง อุณหภูมิสีโดยประมาณ K 
ชนิดแสงขาวขุน (Warm   White  Tube) 
ชนิดแสงกลางวัน (Daylight  tube) 
ชนิดโครมา 50 (Chroma  50 ของ GE) 
ชนิดแสงกลางวัน 5000° (Daylight 5000°) 
ชนิดแสงกลางวัน 5400° (Cool  Daylight  5400°) 
(ของบริษัท  ฟลิปส) 
 

3700° 
4800° 
5000° 
5000° 
5400° 

     
หลอดไฟฟลูออเรสเซนตหรือหลอดไฟวาวแสง  เปนหลอดไฟประดิษฐที่นาสนใจ  นํามาใชในการถายภาพ  
เพราะ ไมรอน ราคาไมแพง  มีคุณลักษณะที่นาสนใจดังน้ี 
หลอดวาวแสง  ตามทฤษฎแีลวตองถือวาไมมีคาอุณหภูมิสีท่ีแทจริง  เพราะการเกิดแสงในหลอดไฟวาวแสง
น้ัน เกิดจากรังสีอุลตราไวโอเลตในหลอด ตกกระทบสารเรืองแสงที่ฉาบไวภายในดานขางหลอด ซ่ึงตางจาก
หลอดจุดไสธรรมดาที่ทําใหหลอดรอน แลวไสหลอดเปลงความสวางออกไป ดังน้ันจึงถือวาหลอดไฟวาว
แสงนี้มีสีของแสงจริง  แตมิไดแสดงระดับของอุณหภูมิ  ความสวางของแสงสวางจากหลอดไฟวาวแสงก็ให
แสงสวาง   เรียกอุณหภูมิสีของหลอดไฟวาวแสงที่คาอุณหภูมิสีเทียบเคียง (correlated colour  tempereture) 
 
3.3)  อุณหภูมิสีของตนกําเนิดแสงธรรมชาติ 
 ในการถายภาพสีดวยฟลม เราตองคาํนึงถึงอุณหภูมิสีของตนกําเนิดแสง  ฟลมที่นํามาถายสไลด 
เชน  ฟลมรีเวอรแซล (Positive   Film) หรือชนิดใชแสงกลางวัน  (Daylight  Type)  ฟลมเหลาน้ีเหมาะกับ
แสงแดดกลางวัน ซ่ึงมีอุณหภูมิสี 5,000° K  ฟลมจะใหสีสมจริงเหมือนธรรมชาติ  ซ่ึงถาอุณหภูมิสีของแสง
เปลี่ยนไปตามธรรมชาติเน่ืองจากทองฟามเีมฆมาก  ชวงเวลาเชา – บาย  ก็จะใหผลของสีแตกตางกันออกไป 
ในเวลากลางวนั   แสงจากดวงอาทิตยจะเปนแหลงแสงธรรมชาติที่สําคัญที่สุด  แตควบคุมไดยากที่สุด  
เพราะจะแปรเปลี่ยนตามวันเวลา  ตําแหนงของดวงอาทิตยในรอบวัน   อุณหภูมิสีดังกลาวน้ีอาจจะแสดงได
ตามตารางขางลางดังน้ี 
ตนกําเนิดแสงธรรมชาติ อุณหภูมิสีโดยประมาณ K 
แสงอาทิตยตอนรุงอรุณ 2000° 
แสงอาทิตยตอน 17.00 น. 4300° 
แสงอาทิตยตอนเที่ยงวัน 5400° 
แสงจันทรคืนวันเพ็ญ 5400° 
แสงกลางวันที่ใชถายภาพสี 5500° 
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แสงกลางวันเฉลี่ยของซีไออี * ชนิดซี 6500° 
แสงกลางวันที่มีเมฆปกคลุมทองฟา 7500°- 8000° 
แสงกลางวันที่ทองฟามีมีฟาเขม 10000°-20000° 

 
3.4) ทฤษฎีของแสงและส ี  

 3.4.1 Correlated color Temperature, CCT.อุณหภูมิของสี (สีของแสง) 
 อุณหภูมิท่ีสัมพันธกันของแหลงกําเนิดแสง แสดงเปนองศาเคลวิน (สัญลักษณ K)  และใชเปน
คําอธิบายแหลงกําเนิดแสงที่มีอุณหภูมิสีสัมพันธที่มีคาต่ํา (2700° K ถึง 3500° K) จัดอยูในกลุมสีอุน เชน สี 
Warm white, White Deluxe และ  Royal white (แสงโคมไฟสวนใหญ มีอุณหภูมิสีระหวาง 2700° K ถึง 
3500° K) แหลงกําเนิดแสงที่เปนฟลูออเรสเซนต มีอุณหภูมิสัมพันธสูงขึ้นมา จัดอยูในกลุมสีเย็น เชน Cool 
white, Cool white Deluxe หรือ แสงกลางวนั อุณหภูมิสีสัมพันธของแหลงกําเนิดสีน้ี มีสวนชวยอยางมากตอ
การปรากฏชัดแจงของพื้นที่ท่ีสวางอยูน้ันทั้งหมด 
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 3.4.2. Color Rendering Index ดัชนีสี CRI 
  ดัชนีสี เปนระบบตัวเลขสากลจาก 0-100 ซ่ึงจะแสดงคุณสมบัติการสะทอนของสีที่สัมพันธ
กันของแหลงกําเนิดแสง เมื่อเปรียบเทียบกับแหลงอางอิงมาตรฐานของคาแสงแบบเดียวกัน ดัชนีจะแสดงคา
องศาซึ่งสีจะปรากฎแบบ “คุนเคย” หรือ “เปนธรรมชาติ”  ภายใตแหลงกําเนิดแสงที่ถูกเลือกมา โดยปกติ
หากคา CRI ยังสูง   สีของวัตถุภายใตแหลงกําเนิดแสงนั้นจะดีขึ้นตามลําดับ คาดัชนี CRI ของแหลงกําเนิด
แสง 2 จุด ควรนํามาเปรียบกันเฉพาะเมื่อท้ังสองแหลงมีอุณหภูมิสีสัมพันธตัวเดียวกันเทาน้ัน 



 29

การแกไขปญหาและพัฒนางานถายภาพ : ไฟถายภาพ 
ปญหา : ไฟถายภาพที่มีอยูยังไมเหมาะกบัการถายภาพหนังสือหายาก เน่ืองจากหนังสือหายากมีสีตางจาก
หนังสือทั่วไป(จากความเกา)  
 งานถายภาพไดปรับปรุงไฟถายภาพ พรอมแทนถายภาพ copy stand โดยใชหลักการดังน้ี คือ 
การใชไฟ Daylight น้ันตองใชกับฟลม Day light  สีจึงจะออกมาถูกตอง โดยเฉพาะไฟน้ําเงิน Blue Daylight  
หลอดไฟฟาชนิดหลอดไส เปน“หลอดไฟฟาชนิดเปลงแสงจากวัตถุรอน” ภายในหลอด ไฟฟาไหลผานไส
เปนขดลวดบางๆที่มีความตานทานสูง  ลักษณะของไสหลอดจะขดเหมือนสปริง มีขนาดแตกตางกัน ข้ึนอยู
กับกําลังไฟฟาของหลอดไฟฟา  หลอดที่มีกําลังไฟฟาต่ําไสหลอดจะใหญ ความตานทานนอย สวนหลอดท่ี
มีกําลังไฟฟาสูงไสหลอดจะเล็กและมีความตานทานมาก 
 หลอดไสมีหลักการทํางาน คือ เม่ือกระแสไฟฟาผานไสหลอดที่ทําจากทังสเตน ซ่ึงเปนโลหะที่มีจุด
หลอมเหลวสูง จะทาํใหไสรอน เม่ืออุณหภูมิสูงถึง 500 องศาเซลเซียส ไสหลอดก็จะเริ่มเปลงแสงพรอมท้ัง
ปลอยความรอนออกมา ไสหลอดยิ่งรอน แสงสวางก็ย่ิงเพิ่มขึ้นตามไปดวยเม่ือเทียบกับหลอดชนิดอื่น แตก็มี
ความสิ้นเปลืองเพราะเปนหลอดประสิทธิภาพตํ่า พลังงานหมดไปกับการแผรังสีความรอน รังสีอินฟราเรด 
มีเพียง 6 เปอรเซ็นตที่ใหแสงสวาง มีอายุการใชงานสั้น 1,000 ช่ัวโมง  จากนั้นการใหแสงสวางก็จะลดลง  
การทํางานใชการติดต้ังหลอดโดยใชแทนกอปปใหไฟสองเขา 45° ท้ังสองขาง คือ ขางซายและขางขวา  ก็จะ
ไดแสงสวางสําหรับการทาํงานถายภาพ  ชิ้นงานตางๆ สามารถถายสไลด ภาพดิจิทัล ภาพสีที่มีสีสันสวยงาม 
ถูกตอง  แตมีขอเสีย คือ รอนมากๆ และหลอดไฟ Daylight น้ีมีราคาแพง  จัดเปนวัสดุส้ินเปลือง และหาก
ตองถายสไลดจํานวนมาก จะไมสะดวก อยางไรก็ตามวธีิน้ีก็ไมตองคอยแสงแดด 
   
การทดลอง  

หลอดฟลูออเรสเซนต (fluorescent) /หลอดเรืองแสงหรือหลอดวาวแสง “ไสหลอด” ทําดวยโลหะ
ทังสเตนอยูที่ขั้ว  ภายในหลอดฟลูออเรสเซนตสูบอากาศออกจนหมดแลวใสไอปรอทไว  ดานในฉาบดวย
สารวาวแสง ( fluorescent coating ) ซ่ึงจะใหสีตางกัน หลอดฟลูออเรสเซนตเปนหลอดที่มีหลักการใหแสง
สวาง โดยไมเก่ียวของกับการทําใหเกิดความรอน แตใชการถายเทประจุไฟฟา เม่ือจายกระแสไฟฟาเขาไปยัง
ขั้วหลอดทั้งสองขางดวยความตางศักยที่สูง  จะทาํใหขั้วทังเสตนปลอยอิเล็กตรอนออกมาพรอมกันท่ีปลาย
ทั้งสอง ทําใหมีการไหลของกระแส เกิดการอารคระหวางปลายขั้วทั้งสอง  ความรอนจากการอารคจะทาํให
ปรอทเปนไอ การเคลื่อนตัวของอิเล็กตรอนในไอปรอทมีการปลอยรังสีอัลตราไวโอเลต ทําใหสาร
ฟอสเฟอรที่เคลือบดานในหลอดแกวเรืองแสง  หลอดใหแสงสวางสม่ําเสมอ 
 
 การดําเนินการทดลองในการนี้  งานถายภาพไดทดลองนําหลอดฟลูออเรสเซนต GTE Sylvania 
รุน Design 50 มีคา CCT  5000° K, คา CRI = 91 ซ่ึงคาสีของแสงที่ไดจะเปน Daylight เทากับแสงสะทอน
ของแดดภายนอก แตของงานถายภาพจะคงที่  ท่ี 5000° K และมีคา CRI 91 ซ่ึงคาขนาดนี้ จะใหสีถูกตองตาม
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ความจริง จึงนําหลอดนี้มาใชโดยตรงในการถายภาพ โดยทําเปนโคมไฟใสหลอด ขางละ 4 หลอด ทั้ง
ดานซายและขวา ทาํใหไดแทนกอบปพรอมโคมไฟ (ดูรูป) เปนชุดสําเร็จพรอมใช  ทําใหสามารถใหบริการ
ถายภาพในหองปฏิบัติการถายภาพของงานถายภาพไดตลอดเวลา 
 
 

 
 
 
  ตัวแปรการทดสอบ  ไดทดสอบโดยใชฟลมสไลดสี และฟลมสี และถายภาพดิจิทัล ถายไฟ 
Day light ถายแสงแดดเวลา 10.00 น. ในวันที่มีอากาศแจมใส และถายไฟถายภาพ Design 50 โดยถายแผน
ทดสอบสี The  macbeth color checker (color Rendition Chart) 
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  ผลการทดสอบ  ภาพที่ไดจากฟลมสไลดสี และฟลมสี และภาพถายดิจิทัล คุณลักษณะของสี
ไมแตกตางกัน จากไดทดลองปฏิบัติ  ปรากฎวาผลเปนที่ยอมรับและพึงพอใจ สําหรับเจาของงาน 
 
ผลตอเน่ืองจากการทดลอง 

ปจจุบัน งานถายภาพไดพัฒนาและปรับปรุงไฟถายภาพเพิ่มเติม โดยนําหลอดคอมแพคฟลูออเรส
เซนต (หลอดตะเกียบ) ชนิดที่มีบัลลาสตอยูภายในใชแทนหลอดฟลูออเรสเซนตทรงกระบอกยาว ทําใหมุม
ของการใหแสง/ หลบแสงสะทอนดีขึ้น  โดยคุณสมบัติที่สําคัญของหลอดตะเกียบชนิดน้ี คือ ชวยประหยัด
พลังงานไฟฟาและมีอายุการใชงานที่ยาวนานกวาหลอดฟลูออเรสเซนต โคมไฟสองลงในพ้ืนที่ ใหแสงทั่ว
ในบริเวณที่จําเปนตองเปดไฟไวนาน  
 
แสงและลักษณะของตําแหนงดวงไฟ 
 แทนกอปปที่ติดกลองแลวน้ัน เม่ือวางหนังสือก็พรอมจะถายไปไดทีละหนา โดยอาจอาศัยแสงจาก
ธรรมชาติ คือแสงแดด โดยใหแสงเขาทางดานหนา ไมมีอะไรมาบังเวลาถาย  สังเกตสภาพแสงที่ตกกระทบ
บนหนากระดาษวา เรียบเสมอกันก็ใชได  แตถาไมมีแสงแดด ก็ถายไมได  หากมีแสง แตสภาพแสงไมดีก็
ถายไมได นอกจากนั้นระดับความเขมของแสงที่เปล่ียนไป จะทําใหสีของภาพ คือสีของหนากระดาษ
แตกตางกันไปอีกดวย  ในการทํางานโครงการจัดทําหนังสืออิเล็กทรอนิกสครั้งน้ี งานถายภาพไดทดสอบ
ออกแบบไฟโดยใชไฟประดิษฐ มาเปนแหลงกําเนิดแสง  เพ่ือใหไดสภาพแสงที่สม่ําเสมอ อํานวยความ
สะดวกในการปฏิบัติงานไดเปนอยางดี  
 การถายทําควรวางแทนกอปปภาพบนโตะสูงขนาดพอเหมาะกับตัวบุคคลผูปฏิบัติงาน จัดตําแหนง
ดวงไฟใหสองสวางลงที่บริเวณหนังสือบนกระดานของแทนกอปป  ใหแสงสวางน้ันเกลี่ยท่ัวหนาหนังสือ
ใหแสงเขาทางดานขาง คือดานซาย และขวาทาํมุม 60  
 ตําแหนงของแสงมีผลตอคุณภาพของภาพมาก  ในกรณีมุมหลอดไฟสองแสงทํามุม 60  กับ
แกนกลางของกลองน้ัน  จะทําใหแสงมีมมุที่หางจากเลนสของกลอง  ทําใหลดการสะทอนแสงของภาพไป
ยังเลนสนอยลง ทําใหลดการแฟลรลง  นอกจากนั้นการใชเลนสฮูดสวมไวหนาเลนสแมคโคร  ก็ชวยปองกัน
ไดระดับหน่ึงเชนกัน  เม่ือสภาพแสงที่ใชในการถายภาพมีคุณภาพดี มุมในถายภาพทําใหการสองสวาง
ถูกตอง แสงสวางเกล่ียบนผิวกระดาษดี  ผลลัพธ คือ  ความเปรียบตางของสีขาวและดํา(Contrast) ดีขึ้นและ
ทําใหภาพมีความอิ่มตัวของสี คือ Saturation สมบูรณดี 
 อยางไรก็ดี การวางตาํแหนงไฟนั้นข้ึนอยูกับลักษณะของไฟ  ไฟสมัยใหมเปนแบบหลอดตะเกียบ 
ไฟเปนแผงสี่เหลี่ยมมีแผนกระจายแสง  ลดการ Hot spot ลงที่แสงบนวัตถุได    อน่ึงการจัดไฟท่ีตําแหนง   
45 - 60  จากแกนกลางก็เปนมุมที่ใชได     ในการถายกอปปภาพ ตองหมั่นสังเกตและคอย ๆ  ถายทํา เก็บ
รายละเอียดผลงานและทดสอบตัวแปรตางๆ จนกวาจะไดเปนที่พึงพอใจ 
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4. สายลั่นไกชัตเตอร 
การใชสายลั่นชัตเตอรซ่ึงเปนอุปกรณสําหรับกดชัตเตอรน้ัน  เม่ือติดตั้งกลองรวมกันกับขาตั้งแลว 

สายลั่นชัตเตอรจะชวยลดความสั่นสะเทือนในการกดชัตเตอร  ทําใหภาพไมส่ันไหว  และยังใชล็อคชัตเตอร
เมื่อเวลาตองการบันทึกภาพเปนเวลานานๆดวย   สายลั่นไกชัตเตอรราคาไมแพง  ชวยใหกดชัตเตอรได
นุมนวลและไมทําใหกลองส่ันไหว 

 
5. ขาตั้งกลอง 

ขาตั้งกลองเปนอุปกรณสําหรับการตั้งกลองเพื่อใหกลองน่ิงมากกวาการถือกลองดวยมือ  ขาต้ัง
กลองมีความจาํเปนมากเมื่อตองถายภาพนานๆ   ควรเลือกใชขาต้ังสําหรับตั้งกลองชนิดที่แข็งแรง  เน่ืองจาก
บางครั้ง ชางภาพก็ตองถายภาพในที่ๆ มีแสงนอยๆ  การจะใชเลนสขนาดใหญหรือมีนํ้าหนักมากๆ ทําไดไม
สะดวก และหากไมใช ภาพก็จะสั่นไหว  ไมคมชัด  ดังน้ันในที่มีแสงนอยและไมสามารถถือกลองดวยมือ 
หรือเมื่อตองใชความเร็วชัตเตอรต่ําๆ เพ่ือใหแสงพอดี  จึงตองอาศัยขาตั้งกลองชวย  ขาตั้งกลองที่ไมแข็งแรง
ทําใหไดภาพที่ถายพรามัว ไมคมชัดไดเชนกัน  ในกรณีที่ไมแนใจวาขาต้ังจะมั่นคงดีหรือไม    ใหเตรียมใช
ถุงทรายหนักๆ ตางน้ําหนักแขวนถวง เปนการลดความสั่นสะเทือนลง   สวนการใชสายล่ันชัตเตอรซ่ึงเปน
อุปกรณสําหรับกดชัตเตอร  เม่ือติดตั้งกลองรวมกันกับขาตั้งแลว สายลั่นไกชัตเตอรจะชวยลดความ
ส่ันสะเทือนในการกดชัตเตอรไดอีกทางหนึ่งดวย  เพ่ิมความมั่นใจวาภาพจะไมส่ันไหว  

บางครั้งพบวาหนากระดาษมีใบแทรกเปนแผนที่ขนาดใหญ ชางภาพไมอาจถายภาพไดโดยใชแทน
ถายภาพปกติ ชางภาพตองดัดแปลงโดยการนําขาตั้งกลองมาใชยึดกลอง เอกสารที่จะถายตองแผออกขึงให
ตึงจัดมุมกลองและระดับใหภาพอยูในกรอบจึงจะถายทาํได 

 
6 . กระดาษสีดําดาน  
 กระดาษสําหรับรองหนากระดาษเพ่ือถายภาพ ควรเลือกใชกระดาษโปสเตอรสีดําดานสนิท ใหตัด
ไวหลายๆ  ขนาด  โดยใหมีขนาดใหญกวาหนาหนังสือ 
 
7. กระจกดาน (Matte mirror) 
กระจกดาน  เปน กระจกพ้ืนผิวเรียบและไมสะทอนแสง ควรจัดหาไวและตัดไวเพ่ือทับหนากระดาษใหเลือก
ตัดไวหลายๆ  ขนาด  เชน ขนาด 5" x  7"  ขนาด 8"  x 10" และ 10" x 12"  เจียรมุมดวยหินลับมีดหรือกระดาษ
ทรายขัดเหล็ก จากน้ันใชกระดาษกาวแรกซีนหุมขอบกระจก 
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ขั้นตอนการถายภาพ 
 1. ยึดจับกลองกับอุปกรณ  ยึดขันกับสกรู ยึดกลองใหแนน ดูระดับของกลองวาขนานกับพ้ืนแทน
กอปปหรือไม ถายังไมขนาน ตองเปลี่ยนใหไดระนาบขนาน อาจใชทีว่ัดระดับน้ําชวย 
  2. วางหนังสือที่จะถายลงบนพ้ืนแทนถายภาพ 
  3. มองในวิวไฟนเดอรกลอง หรือ จอ LCD ของกลองวาไดระนาบ  ภาพมีอาการบิดเบอืนเอียงซาย
หรือไม 
  4. วัดแสงและลงมือถายทําไดปกติเหมือนการถายภาพทั่วไป  
Photo tip 

Mode Live View โหมดน้ีจะชวยใหในขณะทําการถายภาพ  ชางภาพจะมองในชองมองภาพเพื่อดู
รูปท่ีจะถายหนังสือหายากแตละหนา  เม่ือจัดเรียงหนาตามลําดับที่จะถายแลวน้ัน  กลอง 35 DSLR บางรุน 
ชางภาพสามารถใชจอ LCD ดานหลังและปจจุบัน (2009) นิยมทําจอภาพขนาด LCD ใหญ  ชวยในการ
มองเห็นภาพที่จะถายไดดีขึ้น  ชางภาพสามารถเลือกองคประกอบ  จัดสัดสวนภาพ ดู ความเหมาะสมไดดี
ย่ิงข้ึน  เพราะมองเห็นไดชัดเจนมากกวาในชองมองภาพ  การถายหนังสือหายากน้ี  ตองพิจารณาทัง้ความ
คมชัดและความสวางของหนากระดาษวา มีคุณภาพของสีและการตัดกันของตัวหนังสือและพ้ืนกระดาษวา
เปนอยางไร 

 
การเลือกโหมด Program 
การเลือกโหมด Program ของกลองดิจิทัล DSLR ที่เหมาะสมจะทาํใหการปฎิบัติงานงายข้ึนและ

สะดวกรวดเร็วมาก mode AV หรือโหมด Arerture priority ชางภาพใชเพ่ือเลือกควบคุมความชัดลึกของภาพ
ในโหมดนี้ เม่ือตั้งคารูรับแสงที่ f/22 จะเปนการตั้งระยะความชัดลึกของเลนสถายภาพมากที่สุด กลไกของ
กลองจะเลือกสปดชัตเตอรที่สัมพันธกันให ถึงสปดชัตเตอรจะต่าํก็ไมเปนไร เพราะตัวกลองยึดอยูกับแทน
กอบปอยางแนนหนาแลว ชางภาพจึงอาจใชสปดชัตเตอรต่ําๆ ได โดยไมตองกลัวภาพจะสั่นไหว (แตก็ควร
ใชสายลั่นไกชัตเตอรดวย) 

 
การตั้งคา ISO  
ISO  คือคาความไวแสงชางภาพเลือก การตั้งคา ISO สําหรับสภาพแสงเมื่อสภาพแสงนอย จะเลือก

ต่ํา คา ISO สูงๆเชนที่800,1600 แตถาสภาพแสงมากจะตัง้ ISO ต่าํเชนที่100,200ที่คาISO ตํ่าจะเกิด Noise ใน
ภาพนอย และในทางกลับกันถา ISO ย่ิงสูงมากๆ ก็จะมี Noise เกิดขึ้นมาก 
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ในการจัดทําหนังสือหายาก ชางภาพจัดสภาพแสงใหเหมาะสม คือ มีปริมาณแสงเกลื่ยลงในหนา
หนังสือพอดีแลว จึงเลือกใช ISO ประมาณ 200 เพ่ือหลีกเล่ียง Noise ท่ีจะเกิดขึ้น 

 
 
 

การวัดแสง  (Metering) 
 กลอง  DSLR สมัยปจจุบันมีการวัดแสงที่แมนยําและเที่ยงตรงมากในการวัดแสงนั้น จะมีรูปแบบ
การวัดแสงที่แตกตางกันออกไป แตผลลัพธก็คือ ชางภาพตองการวัดแสงใหพอดี ถาวัดแสงผิดพลาดผลที่
เกิดข้ึนคือ ภาพที่บางไป ภาพออกมาสวางมาก เรียกวา ภาพโอเวอร  (OVER)  ในทางตรงกันขามถาวัดแสง
แลวภาพที่ออกมาดํามืดเกินไป เรียกวา ภาพอันเดอร (UNDER)  ภาพใน 2 ลักษณะนี้เปนภาพที่ขาด
รายละเอียดและไมมีคุณภาพ หมายรวมถึงวา การถายภาพน้ันไมมีคุณภาพดวย 
 ชางภาพตองพยายามวัดแสงใหภาพที่ถายไดออกมาพอดี ตรงน้ีตองใชทักษะและความสังเกต จดจํา
อยูบอยครั้ง แตกฎพ้ืนฐานอยางแรกคือ ตองเขาใจระบบการวัดแสงของกลองกอน 
 
การวัดแสงของกลองน้ัน มี 3 แบบ หลักๆ คือ 
 1. การวัดแสงแบบเฉพาะจุด (Spot Metering)  กลองจะวัดแสงเฉพาะจุดเทาน้ัน  แบบวิธีวัดแสง
แบบนี้ จะใชเฉพาะภาพวัตถุที่ตองการเนน ตรงจุดน้ันๆ ก็จะพอดี ซ่ึงโดยปกติ การวัดแสงเฉพาะจุด จะวัด
ประมาณ 3-4% ของพ้ืนที่ ทําใหตรงจุดพอดี แตบริเวณฐานรอบนอกจุดน้ันๆ ก็จะมืด หรือ สวาง แลวแต
สภาพแสงและบรรยากาศ 
 2. การวัดแสงแบบเฉลี่ยหนักกลาง(Center weighted Metering)  การวัดแสงแบบนี้เหมาะสําหรับ
การถายภาพกรณี วัตถุในภาพอยูตรงกลาง (มีมวลนํ้าหนักภาพเนนตรงกลาง)  ของภาพ กลองจะวัดแสง
เฉพาะวัตถุในภาพอยูตรงกลาง และวัดแสง รอบนอกดวยเล็กนอยทําใหภาพที่ถายไดมีสภาพแสงพอดี เพราะ
การวัดแสงแบบเนนเฉพาะวัตถุอยูตรงกลาง 
 3. การวัดแสงแบบเฉลี่ยทั้งภาพ (Average Metering ) การวัดแสงแบบนี้ กลองจะทําการวัดแสง
เทากันทุกพ้ืนที่ในภาพ แลวกลองจะนํามามวนในหาคาเฉลี่ยใหกับภาพท้ังหมด วิธีการวัดแบบน้ีดีตรงมัน
สะทอนความเปนจริง เชน ถาพ้ืนที่สวนใหญมืด ภาพที่ไดก็จะออกมามืด แตถาภาพสวนใหญเห็นภาพสวาง 
ภาพที่ไดก็จะออกมาสวาง ทั้งที่ในความเปนจริงชางภาพ ตองการใหภาพออกมาพอดี  
 ในการปฏิบัติงานถายภาพ หนังสือหายาก การเลือกระบบวัดแสงของกลองใหเลือกระบบวัดแสง
แบบเฉลี่ยทั้งภาพ เพราะวาเปนการวัดหนากระดาษทั้งหนา และหนากระดาษมีสีขาวหมนจนถึงสีนํ้าตาล ตัด
กับหมึกจากการพิมพตัวตะกึ่งสีดํา จากนั้นใหทดลอง สังเกตผลลัพธที่ได จากนั้นใหชดเชยแสงของกลอง
โดยใช โหมด conpensate( 1+........0........- )1ทดลองถายทําดูสังเกตและจดบันทึก ทดลองจนไดคาที่พอดี 
สําหรับ การถายภาพหนากระดาษ 
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เทคนิคเพ่ือความคมชัดของการถายภาพหนังสือหายาก 

ในการถายภาพหนังสือหายากนั้น ชางภาพจะพลิกหนากระดาษไปทีละหนา มองในวิวไฟนเดอร
ของกลองและดูภาพหนาหนังสือท่ีปรากฏในจอภาพวา หนาเอียงซายขวา ตองหนุนรองดวยวัสดุใดใหได
ระดับ ถึงจะถายได  หลักสําคัญคือ ทําใหหนาแผนกระดาษนั้นเรียบท่ีสดุ จึงจะลงมือถายทําหนาน้ันได 
บางครั้งตองใชวิธีการกดอยางระมัดระวัง หรือใชวัสดุมีนํ้าหนักทับ เม่ือแกไขปญหาความเรียบไดแลว ก็
พรอมถายได  การใชกระจกทับหนากระดาษขณะถายภาพ ก็เปนอีกวิธีหน่ึงที่ชวยใหหนากระดาษเรียบ     
ไมโกงหรือโคงงอ   กระจกน้ันเลือกใชกระจกที่เรียกกันวา  กระจกดาน (Matte mirror) เพราะเปนกระจกที่
นอกจากเปนพ้ืนผิวเรียบแลวยังไมสะทอนแสง ไมกอใหเกิดจุด hot spot บนพ้ืนผิวกระจก  แตบางครั้งเนื้อ
กระดาษการพิมพหนาหนังสือน้ันมีปญหา เชน ใชหมึกดําและกระดาษหนังสือบาง ทําใหหมึกซึมขึ้นมาเปน
เงาสีเทาดําลางๆ ใหแกปญหาดวยการนํากระดาษสีดํามารองดานใต จะชวยแกปญหานี้ได 
 ในสวนที่เปนเลนสถายภาพนั้น หากชางภาพเลือกใชเลนสแมคโคร ควรเลือกเปดกลอง คือรูรับแสง
ใหเหมาะสม ไมควรเลือกเปดรูรับแสงคาเลขเอฟสูงๆ เชน 22 เพ่ือเนนความคมชัดลึกเกินไป เพราะ ที่คาเอฟ
ขนาดน้ี ชองเปดรูรับแสงของเลนสนั้นมีขนาดเล็กเกินไป จะทําใหเกิดการเลี้ยวเบนของแสง  แสงที่เล้ียวเบน
น้ีจะทําใหคุณภาพของภาพที่ไดต่ํา มีผลทําใหคุณภาพของภาพที่ไดไมคมชัด 

 
 
 

ขั้นตอนการปรับแตงภาพใหสวยงามกอนนําสง 
ในกระบวนการถายภาพดิจิทัลน้ันเมื่อถายภาพแลวชางภาพตองใชโปรแกรมตกแตงภาพ Photoshop  

CS แตงภาพทางเทคนิคเพ่ือใหสวยงามมากกวาที่ถายมาได เชนโดยใชคําสั่งปรับแตงสีและแสงเงา อยูใน 
เมนู Image >ADJUSTMENT เชน  การปรับดวยคําส่ังอัตโนมัติ (Auto  Levels)การปรับความคมชัด  
(Sharpness)   ,การปรับคาความสวางและความมืดของภาพ (over and under  exposure) 
โดยพิจารณาเครื่องมือ/คาการทํางาน ตาง  ลักษณะ  ซ่ึงชางภาพทุกคนตองสามารถปฏิบัติได ดังน้ี  
 
1. คาโทนสี การ ปรับแตงสีและแสงเงา Levels 
เน่ืองจากชวงโทนสีของกลองแคบ ภาพท่ีไดจึงมีสีความเขมนอยกวาฟลมสไลด ชางภาพตองปรับคาโทนสี 
(level) เพ่ือใหไดภาพที่มีความเขมข้ึน หรือภาษาถายภาพคือ “มีเน้ือน่ันเอง”   
การปรับคา Levels  มี 2 วิธีดวยกัน คือ 
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          1) ปรับดวยคําส่ังอัตโนมัติ (Auto  Levels)  
สามารถใหโปรแกรมปรับคาอัตโนมัติได โดยคลิกเมนู  Image > Adjustments > Auto  Levels   
โปรแกรมจะประมวลผลปรับระดับความอิ่มตัวสีใหโดยอัตโนมัติ 
1.เปดไฟลภาพ 
2.เลือกคําส่ัง  Auto  Levels 
3.ภาพจะอ่ิมตัวสีมากข้ึน 
          2.) การปรับแตงดวยคําสั่ง (Manual  Levels)  
ในบางครั้งการปรับแตงภาพอัตโนมัติจากคําสั่ง Auto  Levels  อาจไดภาพไมสวย (เน่ืองจากลักษณะของ
ภาพ)  เราสามารถปรับไดโดยคลิกเมนู  Image > Adjustments>  Levels….  เม่ือปรากฎหนาตาง  Levels  ให
เล่ือนเมาสปุมสามเหลี่ยม  ปรับคาพรอมสังเกตผลลัพธ  (เพ่ิม – ลดคาชอง  Input  Levels)  
คานอยลงจะทําใหภาพเขมและตัดกันมาก  คามากขึ้นทําใหภาพสวางและตัดกันนอย 
1.เปดไฟลภาพ 
2.เลือกคําส่ัง  Levels 
3.ปรับคาสังเกตภาพและที่ตองการ 
4.ภาพจะอ่ิมตัวสีมากข้ึน 
2. การปรับคาความสวางและความมืดของภาพ (over and under  exposure)โดยใชคําสั่งปรับคาความสวาง
และความมืดของภาพ อยูใน เมนู IMAGE >ADJUSTMENT>CURVES 
วิธีการปรับภาพถายที่มืดใหสวางขึ้น  (Under  exposure) 

 ภาพมืด ที่เรียกวาภาพ “Under exposure”  น้ัน มีวิธีการแกไข คือ เพ่ิมความสวางใหกับภาพ   
ปจจุบันไฟลภาพดิจิทัลที่ถายมา Under สามารถแกไขได โดยแกไขความสวางเฉพาะสวนที่มืดในภาพดวย
คําสั่งในโปรแกรม Photoshop  วิธีการเพิ่มความสวางภาพดวยคําสั่ง  Curves  ทําไดดังน้ี 

 1. สราง  Selection จุดที่ตองเพิ่มความสวาง 
 2. ใชคําส่ัง  Curves…เลือกคําสั่งปรับสีแบบเสนโคง  ใหคลิกบนเสน   
 3. ลากเมาสเพ่ิมความสวางใหกับทั้งภาพ  Channel : RGB    
 

วิธีการการปรบัภาพถายที่สวางเกินไปใหเขนขึ้น  (Over  exposure) 
 ภาพที่มีความสวางมากเกิน  เรียกวา “Over  exposure”  วธีิแกไขโดยปกติคือ ลดแสงใหนอยลง
กวาเดิม ไฟลภาพดิจิทัลสามารถแกไขใน  Photoshop  ดวยขั้นตอนดังน้ี 
  1. คลิกปุมเมาส เลือกคําส่ัง Curves… 
  2. คลิกบนเสนและเลื่อนลงเพ่ือใหระดับสีอิ่มข้ึน 
  3. สังเกตภาพผลลัพธที่ได 
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3. คาการปรับความคมชัด (Sharpness)  โดยใชคําสั่งปรับปรับความคมชัด อยูใน เมนู FILTERr>SHARPEN 
 
แมวาคุณภาพของ CCD  และ CMOS จะดีเพียงใด ก็ยังไมสามารถใหคุณภาพของไฟลภาพคมชัดเทาฟลมได   
การใช Mode  Sharpening  ใน Photoshop  CS  จะทาํใหไฟลภาพดิจิทัลมีความคมชัดมากขึ้น ซ่ึงสามารถทาํ
ไดดังน้ี 

1)  ใสฟลเตอรใหภาพชัด 
Copy  เลเยอรเพ่ิมขึ้น 1  เลเยอร ใสฟลเตอร  Unsharp  Mask  ผลทําใหภาพชัดขึ้น สามารถกําหนดคาความ
คมชัดใหเพ่ิมข้ึนตามตองการ  ดูผลลัพธจากชอง Preview  ของฟลเตอร 

1. Copy  เลเยอร 
2. ใสฟลเตอร  Unsharp  Mask… 
3. ปรับคาใหภาพชัดขึ้น 

  Amoun t  : 500 (เพ่ิมความชัด) 
  Radius      : 3.0 (คารัศมีการเพ่ิมความชัด) 
  Threshold : 5   (เกลี่ยระดับความคมชัด 5 ระดับ) 
2)  เปลี่ยนโหมดใหภาพเปนธรรมชาติ 

การใสฟลเตอรเพ่ิมความคมชัดมากขึ้น  ทําใหภาพเกิด Grain หรือจุด  pixels  ภาพจะดูแตก ไมเปนธรรมชาติ
ตองเปลี่ยน  Blending  Mode   ใหภาพเกล่ียจุดเหลาน้ีอยางนุมนวล  หลังจากแกไขเสร็จก็สามารถรวมเลเยอร
เปนภาพปกติ 

 1. เลือกโหมด  Luminosity 
 2. คลิกเมนู  Layer > Flatten  Image 
 

โดยใชคําสั่งการตัดสวนภาพ อยูใน เมนู Image> Canvas  Size   
 
4. คาการตัดสวนภาพ (Cropping)  โดยใชคําส่ังการตัดสวนภาพ อยูใน เมน ูImage> Canvas  Size   
การตัดสวนภาพในโปรแกรมตกแตงภาพ  Photoshop  CS  ก็เหมือนกับการตัดสวนภาพ (Cropping)ในหอง
มืดเวลาอัดขยายรูปขาวดําหรือรูปสีน่ันเอง  ภาพที่ไดจากการตัดสวน (cropping) จะมอีงคประกอบของภาพ
ที่สมบูรณขึ้น สีและสัดสวนของจุดสนใจในภาพดีข้ึน 
วิธีการครอปภาพเพื่อยอ – ขยายภาพ สามารถทําไดดังน้ี 
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การปรับขนาดภาพใหเปลี่ยนไปสามารถทําไดโดยชุดโปรแกรมสําเร็จรปู ดวยคําสั่ง  Canvas  Size  
( Image > Canvas  Size…)  โปรแกรมจะ  Crop  เหลือบริเวณสวนที่ตองการในภาพ  หรือขยายภาพเพิ่มขึ้น
จากเดิม ตามขั้นตอนดานลาง 

 1.ภาพถาย 
 2.ขนาดเบื้องตน 
 3.กรอกคาลดลง 
 4.เลือกทิศทางการ  Crop 
 5.ปุม Proceed 
 6.ภาพถูก Crop เล็กลง 
 

วิธีการครอปภาพเพื่อเลือกเฉพาะสวนที่ตองการ สามารถทําไดดังน้ี 
การใชโปรแกรมสําเร็จรูป crop ภาพเฉพาะสวนที่ตองการนั้นมักจะใชในกรณีที่ไมสามารถ

กําหนดคาดวยคําสั่ง  Canvas  Size   ไดอยางสะดวก  โดยใชวิธีการดังน้ี  
 1.ลากเมาสเลือกเลือกบริเวณ  Crop   
 2.หมุนกรอบใหพอดีเพ่ือเลือกเฉพาะบริเวณที่ตองการ 
 3.กดปุม < Enter>  
 4.ภาพถูก Crop ใหเล็ก 
 

  
    เม่ือปรับแตงภาพดิจิทัลเรียบรอยแลว ชางภาพตองเก็บไฟลภาพน้ันลง CD/DVD ตามที่กําหนด 
ภาพดิจิทัลแตละแผน แตละซอง/กลองท่ีใสหรือกลองกํากับ ตองลงรายละเอียดของหนังสือใหชัดเจน เชน 
ชื่อหนังสือ ลงวัน เดือน ป จากนั้น จัดกลุม CD/DVD ทั้งหมด  เพ่ือนํามาเขาระบบการจัดเก็บโดยมีการแบง
หมวดหมูใหชัดเจน เพ่ือสะดวกตอการคนคืนเมื่อตองการ   
 
 
ขั้นตอนการนําสงไฟลภาพและตนฉบับคืน 
เมื่อชางภาพเตรียมงานภาพ ตกแตงภาพ และนําใสกลอง/ซอง พรอมระบุรายละเอียดตามกาํหนดแลว จะนํา
ไฟลภาพพรอมตนฉบับหนังสือสงคืนบรรณารักษเจาของงาน ซึ่งเมื่อบรรณารักษรับงานพรอมตรวจสอบ
ความถูกตองครบถวนของขอมูล รวมทั้งตรวจหนังสือตนฉบับวาไมมีความเสียหายแลว บรรณารักษจะเปน
ผูนําขึ้นสูกระบวนการจัดแสดงบนเวบไซต หนา e- Text ตอไป 
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อภิปรายผลโครงการและขอเสนอแนะ 
 

องคความรูท่ีไดจากการจัดทําหนังสืออิเล็กทรอนิกสฯ (Lessons learned) 
 ความพยายามในการแปลงสื่อสารนิเทศเปนสื่อดิจิทัลไดรับการพัฒนามากขึ้นในงานสื่อโสตทัศน
หลายประเภท แตการเริ่มทดลองดําเนินการกับสื่อส่ิงพิมพน้ัน  ศูนยวิทยทรัพยากรไดตัดสินใจเริ่มโครงการ
กับงานหนังสือหายากกอน เพราะนอกจากจะเปนการแปลงสื่อเพ่ืองานบริการแลว ยังไดประโยชนในแงงาน
อนุรักษดวย  เม่ือเริ่มดําเนินงานกับหนังสือหายากไดมีการคิดหาวิธีการหลากหลายเพื่อการทํางานทีม่ี
ประสิทธิภาพประสิทธิผลสูงสุด  เริ่มที่การเลือกวิธีการแปลงหนาหนังสือ  ชวงแรกคิดวาจะเลือกใช
โปรแกรม OCR  (Optical Characters Recognition)แตพบวา เกิดปญหาเทคนิคดานฟอนตอักษร เน่ืองจาก
ตัวอักษรของหนังสือหายากเปนตัวพิมพตะกั่วยุคโบราณ โปรแกรมปจจุบันไมสามารถเลือกหาฟอนตอักษร
อานได   ทางเลือกตอมาคือ การใชโปรแกรมสแกนหนาหนังสือ   ในกรณีของหนังสือใหมถือเปนวิธีที่ดีและ
รวดเร็ว แตหากเปนหนังสือหายากที่เปนหนังสือเกา หนากระดาษบางและกรอบ การสแกนหนาหนังสือ
เทากับเปนการทําลายหนังสือโดยตรง  ทางเลือกที่ดีที่สุดขณะนั้นจึงไดแก การใชกลองดิจิทัลถายภาพทีละ
หนาโดยใชชางภาพผูชํานาญ การนํามาเรียงรอยเปนเลมตามรูปแบบทางกายภาพ 
  

งานถายภาพจงึไดรับมอบหมายใหดําเนินการโครงการทดลองนี้ ( pilot project)  (ตามที่ไดกลาวมา
ในตอนตน)  เมื่อส้ินสุดการทําโครงการฯ งานถายภาพใหไดรับขอความรูอันอาจประมวลเปนองคความรู
เพ่ือประโยชนในการปฏิบัติงานและการจัดทําหนังสืออิเล็กทรอนิกสในอนาคตได ดังน้ี 

 
1. เพ่ิมพูนความรูและทักษะของผูปฏิบัติงานในการถายภาพลักษณะพิเศษ ตัวอยางความรูที่ไดจาก

การศึกษาเทคนิคของเครื่องมือและวิธีการในการถายภาพหนังสือหายากครั้งน้ี ไดแก 
1) ความรูเรื่องการจัดแสงสําหรับหนังสือหายากที่มีสีตางจากหนังสือปกติ (ปรากฏ

รายละเอียดใน การทดลองเรื่องการจัดไฟ) 
2) ชางภาพตองมีและ/หรือเพ่ิมพูนความรูเก่ียวกับการถายภาพและเครื่องมือและอุปกรณ

ถายภาพที่เก่ียวของเปนพิเศษ เชน เลนสมาโคร และ แทนกอปป  
3) เทคนิคการจับภาพใหใกลๆ หมายถึง การนํากลองและเลนฺสเขาใกลใหไดตัวหนังสือ

เต็มหนาพอดี จะเห็นตัวหนังสือชัดเจน ทําใหตัวหนังสือมีความคมชัดเจนมากขึ้น 
4) สังเกตพื้นหลังวามีหมึกพิมพเลอะขึ้นมาไหม  หากมีตองใชกระดาษดําสอดขางใต 
5) สังเกตลักษณะที่แตกตางในภาพ เชน เม่ือเปดถายทีละหนา ตองสังเกตสิ่งผิดปกติกอน

ถายทุกคร้ัง เชน อาจมีเศษวสัดุแปลกปลอมคั่นอยูในหนากระดาษ ตองนําสิ่งผิดปกติ
น้ันออก หรือพบหนา(พิมพ)ผิด 
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6) วิธีการปฏิบัติงานถายภาพดวยกลองดิจิตอล  เปนวิธีหน่ึงที่ใชไดดีในงานหนังสือหา
ยากอิเล็กทรอนิกส  แตก็ไมใชงานงาย ชางภาพตองไดรับการฝกฝนมากพอสมควรใน
ประเด็นดังน้ี 

• ความรูความเขาใจเรื่องกลองอยางดี  ตองรูจักเลือกเลนส/  เลือกกลอง 
• ชางภาพตองเขาใจวิธีการทํางานถายภาพเพื่อใหไดคุณภาพดี 
• ชางภาพตองเปนนักอนุรักษหนังสือดวย  เชน  ในขณะถายภาพนั้นควรตอง

ใสถุงมือขณะจับตองหนังสือและเมื่อทาํการถายทําไปทีละหนาน้ัน  หากมี
หนากระดาษเสียหายตองเพิ่มความระมัดระวังเปนพิเศษ  ตองเก็บชิ้นสวน 
ใสซองกระดาษ เขียนเลขหมายหนาชํารุดหนาซอง  และใสกลองรวมไวเพ่ือ
ความสมบูรณของตัวเลม เมือ่สงคืนแกบรรณารักษ 

  
2.  สรางความรูความเขาใจในคุณคาของหนังสือหายาก ซ่ึงเปนมรดกทางภูมิปญญาของประเทศ 

1) หนังสือหายากสวนใหญเปนหนังสือท่ีมีอายุมาก ตีพิมพขอความรูในอดีต ซ่ึงเปนการ
สงผานมรดกทางวัฒนธรรม และภูมิปญญาจากอดีตมาสูปจจุบัน  การถายทอดจากสื่อ
ส่ิงพิมพซ่ึงไมอาจเขาถึงไดงาย มาเปนสื่อดิจิตอล ซ่ึงสามารถเขาถึงและเผยแพรสู
สาธารณะไดงาย นอกจากจะทําใหสารสนเทศนั้นคงอยูอยางดีแลว ยังสามารถนําเสนอ
สูคนรุนใหมผานเทคโนโลยีที่ทันสมัยไดดวย 

2) เม่ือหนังสือหายากอิเล็กทรอนิกสไดรับการเผยแพรสูสาธารณะอยางกวางขวางแลวน้ัน 
เปนที่เช่ือไดวา หนังสือหายากอีกจํานวนมากที่ยังไมไดรับความสนใจ หรือยังไมเปนที่
รูจัก จะมีการสนใจคนควาศึกษามากขึ้น  

 
3. เกิดความเชื่อมโยงระหวางนวัตกรรมใหมๆ ทางดานเทคโนโลยีสารสนเทศและเทคโนโลยี

ทางการศึกษากับงานหองสมุด 
1) งานหองสมุดแบบดั้งเดิมเนนการรวบรวมสารสนเทศประเภทตางๆ ไวในที่เดียวกัน 

เพ่ือความสะดวกในการคนควาของผูใชบริการ เมื่อเทคโนโลยีใหมๆ พัฒนาขึ้น ส่ือ
อิเล็กทรอนิกสและดิจิตอลสามารถแกไขปญหาในอดีตได ทําใหงานงายขึ้น การ
ผสมผสานเชื่อมโยงความรูและเทคนิคจากตางสาขากอใหเกิดประโยชนสูงสุดในงาน 
ดังเชน การนําความรูในงานถายภาพซึ่งเปนเทคโนโลยีทางการศึกษาประสานความรู
ทางเทคโนโลยีสารสนเทศ เกิดการแปลงสื่อดิจิทัลสําหรับงานหนังสือหายากครั้งน้ี 

2) การเชื่อมโยงและประสานระหวางสาขาวิชาไมเพียงปรากฏในการปฏิบตัิงาน แตยัง
ตองพัฒนาในระดับผูปฏิบัติงานดวย บรรณารักษและนักวิชาการโสตทัศนศึกษาไม
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เพียงตองรับตองานกัน หากตองทําความเขาใจในงานของกันและกัน การเรียนรูและ
ทําความเขาใจในงานที่แตกตางกัน กอใหเกิดภูมิรูในตัวตนของกันอีกสวนหนึ่งดวย 

 
4. เปนตนแบบของการพัฒนาหนังสือหายากอิเล็กทรอนิกสของศูนยวิทยทรัพยากร 

1) เม่ือศูนยวิทยทรัพยากรเริ่มโครงการทดลองหนังสือหายากอิเล็กทรอนิกสน้ัน (2546) 
ยังไมมีหนวยงานบริการสารสนเทศแหงใดจัดทําหนังสืออิเล็กทรอนิกสดวยตนเอง
มากนัก บางแหงที่ดําเนินการ ก็เปนการสแกนหนาหนังสือทั้งส้ิน ศูนยวิทยทรัพยากร
จึงเปนหนวยงานบริการแหงแรกที่ริเร่ิมจัดทําหนังสืออิเล็กทรอนิกสดวยการถายภาพ 
การเปนผูริเริ่มน้ัน มีทั้งขอดีและขอดอย ขอดีคือ การแสดงถึงศักยภาพในการเปนผูนํา
ดานการพัฒนาบริการสารสนเทศและการสรางนวัตกรรมงานเทคนิคและบริการ 
ขอดอย คือ การตองเรียนรูที่จะแกไขปญหาใหไดทันการณ เพ่ือใหงานไมไดรับ
ผลกระทบจากขอผิดพลาด งานถายภาพไมมีโอกาสลองผิด/ถูก  ทุกขั้นตอน
กระบวนงานตองวางแผนอยางรอบคอบ หากไมมั่นใจ ตองทดสอบนอกรอบ เพราะ
เม่ือลงมือปฏิบัติจริง หนังสือหายากเปนทรัพยากรสารสนเทศที่ไมอาจหาทดแทนได 
ตองไมใหเกิดความเสียหายกับตัวเลมโดยเด็ดขาด อยางไรก็ตามขอดอยน้ี สําหรับ
ผูปฏิบัติงานแลว ถือเปนโอกาสในการเรียนรูที่ดีย่ิง เพราะหากไมพบปญหาแลว ก็จะ
ไมเกิดความรู อันเปนเทคนิคที่เกิดจากการพัฒนางาน 

2) เม่ือโครงการฯนี้ส้ินสุดลงและมีการนําหนังสือหายากอิเล็กทรอนิกสขึ้นใหบริการและ
เผยแพรบน website ของศูนยวิทยทรัพยากรแลว  หนวยงานตางๆ จาํนวนมากสนใจ
ติดตอขอเขาชมและศึกษาการจัดทําหนังสือหายากอิเล็กทรอนิกส  ศูนยวิทยทรัพยากร
ไดช่ือวา เปนตนแบบการจัดทําหนังสืออิเล็กทรอนิกส สําหรับหนังสือเกาท่ีมีคุณคา 
และเปน ผูนําในการพัฒนางานหนังสืออิเล็กทรอนิกสท่ัวไป 

3 )    การอนุรักษหนังสือเกาในปจจุบันนี้ ในแงของการปฏิบัติงาน ผูปฏบิัติงานมีการ   
                                  ยอมรับระดับหน่ึงแลววา การใชกลองดิจิทัลที่มีความเหมาะสม และเปนเคร่ืองมือ     

ประกอบการถายภาพที่ดี  สามารถถายภาพหนังสือเกาได และไดไฟลภาพเปนหนา 
หนังสือ 1 หนาหนังสือ ตอ 1 ไฟลภาพ เม่ือนําไฟลภาพหลายๆ ไฟลมาตอกันก็คือ เลม 
หนังสือ  โดยนัยน้ี ในทางปฏิบัติก็สามารถทําหนาหนังสืออิเล็กโทรนิกสได และหลาย     
หนวยงานก็ไดเริ่มใชกลองดิจิทัลปฏิบัติงานในทํานองนี้แลว 

 
 
\ 
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ขอเสนอแนะเพื่อการดําเนินการขั้นตอไปของโครงการ 
 

โครงการตอไป : หนังสือหายากอิเล็กทรอนิกสประเภทเอกสารตนฉบับตัวเขียนสมุดไทย 
เมื่อโครงการนํารอง หนังสือหายากอิเล็กทรอนิกสไดรับผลสําเร็จเปนท่ีนาพอใจระดับหน่ึงแลว ผูเสนอ
ผลงานมีแนวคิดจะพัฒนาจากพื้นฐานความรูน้ีสูการจัดทําหนังสือหายากอิเล็กทรอนิกสประเภทเอกสาร
ตนฉบับตัวเขียนหรือสมุดไทยขาวและสมุดไทยดํา (สมุดไทยใบลาน)ตอไป เน่ืองจากศูนยวิทยทรัพยากร
เปนหน่ึงในแหลงทรัพยากรสารสนเทศประเภทเอกสารตนฉบับตัวเขียนที่ดีที่สุดแหลงหน่ึงของประเทศ 
นอกเหนือจากที่จัดเก็บและใหบริการที่หอสมุดแหงชาติ  แนวคิดที่จะใหงานโครงการหนังสือหายาก
อิเล็กทรอนิกสประเภทเอกสารตนฉบับตัวเขียนเปนอีกหนึ่งในนวัตกรรมเทคโนโลยีเพ่ืองานบริการ
ทรัพยากรสารสนเทศ เพ่ือวัตถุประสงคในการอนุรักษมรดกทางวรรณกรรมและคงคุณคางานบรกิารเพื่อ
การศึกษาคนควาน้ัน  มีตนแบบแนวคิดในการศึกษา (Model Profile) จากโครงการ Codex   
( http://www.codexsinaiticus.org/ ) ซ่ึงเปนงานอนุรักษตนฉบับไบเบิล ที่เขียนดวยลายมือที่เกาแกที่สุดใน
โลก เขียนเปนภาษากรีก มีอายุกวา 1600 ป คนพบ ณ วิหารเซนต แคทเทอรีน เมาทไซนาย โดยชิ้นสวนตางๆ 
ของเอกสารตนฉบับตัวเขียนของไบเบิลน้ีไดกระจัดกระจายอยูในความครอบครองขององคกรรัฐและเอกชน
ตางๆ กัน ถึง 4 แหง ไดแก หอสมุดแหงชาติอังกฤษ  หอสมุดมหาวิทยาลัยไลปซิก  หอสมุดแหงชาติรัสเซียที่
เซนตปเตอรสเบิรก และ วิหารเซนต แคทเทอรีน  ในป 2005  องคกรทั้งส่ีทําความรวมมือในการอนุรักษ 
จัดการถายภาพ  ถายโอนขอความและเผยแพรขอมูลจากเอกสารตนฉบับตัวเขียนดังกลาว ผานโครงงานวิจัย
พัฒนาหลายรูปแบบ  จนบังเกิดผลงานเปน 

เม่ือผูเสนอผลงานตัดสินใจนําแนวคิดจากงานนี้พัฒนาเปนโครงการตอเน่ือง ตองมีการประเมิน
ความเปนไปไดของโครงการฯ  ดวยการวิเคราะหขอมูลพ้ืนฐาน และการศึกษาขอมูลเพ่ิมเติมดานอุปกรณ 
เครื่องมือ เทคโนโลยีและวิธีการ เน่ืองจากเอกสารตนฉบับตัวเขียนสมุดไทย ทั้งสมุดไทยขาวและสมุดไทย
ดํามีลักษณะทางกายภาพที่แตกตางจากหนังสือหายากที่เคยดําเนินงานมากอน ตองพิจารณาเครื่องมือที่จะ
เหมาะสม  ศึกษาเทคนิควิธีที่เหมาะสม เพราะทั้งตัวแปรและปจจัยเปลี่ยนไป รวมท้ังตองศึกษาศักยภาพของ
เครื่องมือ หากไมพรอม อาจตองเตรียมแผนของบประมาณเพื่อจัดซ้ือกลองดิจิทัลและเลนสถายภาพตอไป 
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ตัวอยางการทดลองจัดทํา 
หนังสือหายากอิเล็กทรอนิกส ประเภทตนฉบับตัวเขียนสมุดไทยดําไทยขาว 

เร่ือง อนิรุทธ คําฉันท 
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ภาคผนวก 

ตนแบบการสรางขอมูลอิเล็กทรอนิกสของคัมภีรโบราณ (Bible) 
ดวยการถายภาพ  

The Codex Sinaiticus Project 
http://codexsinaiticus.org 
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Contact | Copyright  

 

• HOME  
• ABOUT CODEX SINAITICUS  
• ABOUT THE PROJECT  
• SEE THE MANUSCRIPT  

• GO TO: 
(Book)

 

Codex Sinaiticus  

Codex Sinaiticus is one of the most important books in the world. Handwritten well over 1600 years ago, 
the manuscript contains the Christian Bible in Greek, including the oldest complete copy of the New 
Testament. Its heavily corrected text is of outstanding importance for the history of the Bible and the 
manuscript – the oldest substantial book to survive Antiquity – is of supreme importance for the history 
of the book. [Find out more about Codex Sinaiticus.]  

The Codex Sinaiticus Project  

The Codex Sinaiticus Project is an international collaboration to reunite the entire manuscript in digital 
form and make it accessible to a global audience for the first time. Drawing on the expertise of leading 
scholars, conservators and curators, the Project gives everyone the opportunity to connect directly with 
this famous manuscript. [Find out more about the Codex Sinaiticus Project.]  

The Codex Sinaiticus Website  

This is the first release of the Codex Sinaiticus Project website. The fully developed website is online 
since July 2009. [Find out more about its current contents.]  

Partner institutions  

The British Library   

National Library of Russia   

St. Catherines Monastery   

Leipzig University Library   

RSSSupported by       
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Detail of scar tissue on Quire 78, folio 6 recto.  

Download the full image. 

News 
Participants 
Conservation 
Digital photography 
Transcription 
Website development 
Website presentation 
Contents of the current release 

The Codex Sinaiticus Project 
The Codex Sinaiticus Project has five principal activities:  

• historical research  
• conservation  
• digitisation  
• transcription  
• dissemination  

Historical research 
In order to clarify the circumstances under which Codex Sinaiticus came to be dispersed between the 
four institutions holding parts of the manuscript today, the project has undertaken new archival 
research to identify and study all relevant archival documents. The documents identified through this 
research are being used as the basis for a new account of the modern history of Codex Sinaiticus, to be 
agreed by all four partner institutions. The agreed account will be published on this website and in the 
project's printed publications. It will accompanied by transcripts or digital surrogates of the key archival 
documents wherever the permission of the owners can be secured. [More…] 

Conservation 
The conservation strategy for the Codex Sinaiticus Project was set out by its Conservation Working 
Party. An initial assessment of the manuscript's leaves in all four locations investigated how much work 
would be required to stabilise them before digitisation and to preserve them for the future. A detailed 
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assessment has been carried out in London, Leipzig and St Petersburg and is underway in St Catherine's 
Monastery. [More…] 

Digitisation 
Digitial photography of the geographically distributed leaves of Codex Sinaiticus is central to the 
Project's virtual reunification of the manuscript. Careful imaging of the original leaves provides a life-like 
view of the pages, thus allowing, for the first time, worldwide access to the manuscript. Images of every 
leaf were taken under evenly distributed ('standard') lighting for the main view of the manuscript. 
Images of every leaf have also been taken under raking light (i.e. lighting only from an angle) to 
emphasise the physical characteristics of the manuscript. [More…] 

Transcription 
A major research project which is led by the Institute for Textual Scholarship and Electronic Editing 
(ITSEE) at the University of Birmingham and funded by the UK's Arts and Humanities Research Council, 
has transcribed the texts of Codex Sinaiticus. The result is a uniquely detailed digital transcription of a 
Biblical codex. [More…] 

Dissemination 
The project has identified a range of products that will build upon the full scholarly reappraisal of the 
Codex and its texts and will also help to bring alive this iconic manuscript for everyone. The website is 
the main medium for making Codex Sinaiticus accessible. Other project outputs include a print facsimile, 
a conference, an exhibition and a popular book. [More…] 
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Lawrence Pordes, Juan Garcés and Ulrich Johannes Schneider (from left to right) in front of a digitisation 
cradle designed by Manfred Mayer at The British Library. (© Charlie Gray)  

Download the full image. 
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Digital photography 
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Website development 
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Website presentation 
Contents of the current release 

Digitisation 
One of the core undertakings of the project was to capture each page of Codex Sinaiticus as a high-
quality digital image. Each image offers a substitute for the real manuscript leaf. Careful imaging of 
Codex Sinaiticus therefore provides a life-like view of the pages and allows, for the first time, worldwide 
access to the manuscript. 

The digital photography of Codex Sinaiticus had to establish the best practice, taking into account that 

1. the leaves could not travel and had to be photographed at four different venues with different 
equipment;  

2. the writing on the leaves had to be readable on the digital images;  
3. the natural appearance of the parchment and ink had to be faithfully reproduced.  

Technical standards 
To make sure that the images produced were consistent, common standards and imaging practices were 
established across all venues by the Technical Standards Working Party. The recommendations 
included equipment (cameras, camera software, lighting, lenses, etc.) and processes (setup, colour 
profiling, etc.). 

Lighting 
When choosing the best lighting conditions for digitising Codex Sinaiticus, two aspects had to be 
carefully balanced. The writing on the leaves had to be readable on the digital images, to allow 
researchers to read and analyse it. At the same time, the natural appearance of the parchment and ink 
had to be faithfully reproduced, to allow the appreciation of the physical traits of Codex Sinaiticus. 

Different angles and levels of intensity were tested for the lighting, as the same set-up had to be used 
for every page. Since each page reflected the light at different angles, owing to the natural undulation of 
the parchment, a compromise had to be found to minimise this effect. Best results were achieved when 
the pages were lit at an angle of 45 degrees on low intensity without any backlighting. 

The parchment leaves of Codex Sinaiticus feature many marks on its surface - pricking holes, ruling 
indentations, as well as many other natural details - which are not easily visible with the 45 degree 
lighting directed from both sides of the page. The decision was therefore made to digitise each page 
twice, the second time with a light source at a low angle from a top corner. These are the 'raking light' 
images which optimise the view of the physical features of the parchment. 

Background 
The leaves of Codex Sinaiticus are so thin that the text from the other side of the page can show 
through when photographed. An appropriate background had to be used to lessen the show-through 
and at the same time to keep as true as possible to the colour of the parchment. 

Tests showed that white background paper allowed a relatively faithful representation of the parchment 
colour. The text, however, was often very hard to read because of the show-through from the text on 
the other side of the leaf. Black background paper, on the other hand, reduced the show-through 
considerably in tests and made the text more readable. The page, however, appeared too dark and the 
colours were not represented faithfully. 
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Test image of a Codex Sinaiticus page on a white 
background. 

Test image of a Codex Sinaiticus page on a black 
background. 

Through testing, the decision was made to opt for a compromise colour. A light brown background was 
chosen that was close enough to the colour of the parchment to give a sense of its warmth, while 
reducing the show-through to a point where it rarely makes reading the page difficult. 

 
See a list of the digitisation experts in the Codex Sinaiticus Project. 
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